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PRACTICO 3 - INTERPOLACION

El material entregado para este practico se encuentra dentro de la carpeta “datos”, la cual contiene 3 sub
carpetas: “mdts” (donde se ira depositando el material creado), “muestras” (contiene diferentes puntos de
muestreos y una grilla, todos los archivos son del tipo vectorial) y “terreno” (contiene el elemento sorpresa).
En especifico, trabajaremos principalmente con los elementos contenidos en la carpeta muestras.

En este practico se desarrollara |a idea de la interpolacién espacial, 1a cual tiene como objetivo representar el
comportamiento espacial de una variable cuantitativa y continua, a partir de un nimero finito de muestras o
puntos conocidos.

Si revisamos los elementos contenidos en la carpeta “muestras”, encontramos:

Grilla (grilla_sist): representa la extension, area geografica del fendmeno que queremos inferir, esa variable
cuantitativa y continda expresada en el espacio.

Los diferentes puntos ahi puestos, son el valor de esa variable medida en puntos especificos (puntos
conocidos, es decir, los valores de muestra). Entre estos, encontramos los archivos:

- Sistemat_at:

- sistemat_at: 140 puntos de muestreo distribuidos de forma sistematica.

- rnd_100 at

- rnd_1200 at

- rnd_100 _at: 100 puntos de muestreo distribuidos de forma aleatoria (random = rnd).
- rnd_1200 at: 1200 puntos de muestreo distribuidos de forma aleatoria.

- estrat_100 at

- estrat_100_at: 100 puntos de muestreo distribuidos de forma estratificada.

- str_1000_at

- str_1000_at: 1000 puntos de muestreo distribuidos de forma estratificada.

Si revisamos la tabla de atributos del archivo “estrat 100", podemos ver que ésta estd compuesta de dos
campos, por un lado, el identificador (id) y por otro el campo “jmu”. Este Ultimo representa el valor de la
variable cuantitativa y continua en los puntos dados.

Como se puede ver, los archivos contenidos en la carpeta muestras corresponden a diferentes formas de
distribuir las muestras, pero... ¢ Cudl es la importancia de la distribucién de las muestras?

- Sistematico: distribucién de las muestras de forma regular, por lo que todas las zonas se encuentran
representas, esto nos pueden entregar informacion respecto a la gran tendencia, pero no asi de la
variabilidad de los datos.

- Aleatorio: Si bien, quedan varios espacios sin representar, sin embargo, permite obtener informacién
sobre la variabilidad de los datos.

- Estratificado: vendria siendo una mezcla de los anteriores, ya que divide el espacio en “n” espacios

iguales y en esos “n” espacios se tiran puntos aleatorios, de esa forma quedan cubiertos los espacios
y la variabilidad de los datos.
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SISTEMATICO ALEATORIO ESTRATIFICADO
La imagen corresponde a los archivos sistemat_at, rnd_100_aty estrat_100_at sobre grilla_stat.

Esimportante considerar la capacidad de tu muestreo para representar ambas caracteristicas de tu fendmeno.

TECNICAS DE INTERPOLACION

Para el desarrollo de los diferentes ejercicios, trabajaremos con: estrat_100_at

Voronoi polygons

Corresponde a una de las interpolaciones mas basicas, es discreta y similar al “vecino mas cercano”.
Vector-> Geometry Tools = Voronoi polygons (tridngulos de thiessen)

En caso de errores:

/' Voronoi polygons ? X
Si no los aparecen todos los
pluggins, se puede deber a que Parameters | log Run as batch process...| | \/oronoi polygons
hicieron correr dos veces el agis s T e e
al comenzar. En ese caso, cerrar y estrat_100_at [EP5G:32719] (. ||D corresponding to those input points.
’ Buffer region

volver a abrir ggis.

Antes de iniciar, asegurense de
tener cargados todos los pluggins
gue les van a ser utiles en el
desarrollo del ejercicio que
quieren realizar (para asegurarse,
comenzar y cargar todos los
pluggins).

Si la interpolacion no les corre,
puede ser también porque tienen
uno de los puntos seleccionados
y el software no puede realizar la

[0.000000 2]|...

‘oronoi polygons

Foblete O/Desktop/tecnicas_interpolacion/datos/mdts fjmu_voronoi.shp |

Open output file after running algorithm

interpolacion con un solo punto.
Deseleccionan la capay vuelvan a 0%
intentar la interpolacion. Close




Para visualizar la interpolacion
recién hecha. Botdn derecho
sobre “jmu_voronoi”, dirigirse a:
Properties = Style 2 Graduated
- columna jmu = Color ramp:
GReys. Clases 16, e invertir la
muestra de los colores, para
que, de esta forma, lo mas
blanco corresponda a lo que
tiene mas valor.

" .
¥ Layer Properties - Voronoi pelygons | Style

= Graduatad ?
« Style Column
— - £

Metod - [culr Tin

c/ Rendering
Color ramp - [source] A
- Display

v Edit Tnvert
0@ Actions

Classes Histogram

. Values
¢ 3o B 23,00 - 36.00

I 3B.00-4.00  35-4g

L] Diagrams #.00-6200 45-g3

fi Metarata Mode | Equal Tnterval o

i
Classi
gty | | =] [ oelete at Classes E
Advanced -

Como se puede ver, el patrén NO es uniforme. También, pueden ver que el resultado corresponde a poligonos

(vectorial).

Inverse Distance Wighting (IDW)

Antes de comenzar, hacer zoom al full extent (4! : ) y asegurarse de tener instalado o instalar el pluggin:

interpolation pluggin.

Dirigirse a: Raster = Interpolation = Interpolation (corresponde a un algoritmo genérico)

En este caso, se trata de un raster, por lo mismo se debe resolver cudl sera la extension de ese raster. De forma

manual  se e | # iterpolation plugin X

puede ajustar la Input Output

extensién, en este Vector layers estrat_100_at + | Interpolation method | Inverse Distance Weighting (IDW) ~

caso aj ustar al Interpolation attribute | jmu hd Number of columns ‘755 S | Number of rows _

CUrrent eXtent q ue Use z-Coordinate for interpolation Cellsize ¥ ‘ 1.00000 = | Cellsize ¥

corresponde al Add Remove Xmin (318174 | % max [318938 |

4rea geografica Vector laver Attribute Type ¥ min [6.27333e+06 | ¥ max [6.27444e+08 |
estrat_100_at jmu Points - | P ——— |

gue cubre la capa.
Por otro lado, la
resoluciéon

responde a
cuantas unidades

Cutput file |ﬂJsers,|’JaviEra Poblete O/Desktopftecnicas_interpolacion /datos fmdtsfjmu_IDW |

Add result to project

de mapa mide
cada pixel.

Cancel



A diferencia de los poligonos de Voronoi, ahora se tiene una
cosa mas continua.

También podemos ver la aparicién de aparatos. Pero, é Qué son
los aparatos?

Aparato: patron espacial que aparece en el modelo producto de
la distribucion de las puntas y por sobre todo del método de
interpolacion. En este caso, utilizamos el inverso de la distancia,
gue no es mas que un promedio ponderado, pero es ponderado
por el inverso de la distancia.

Ponderacion: 1/d", donde: d corresponde a la distancia entre el
punto problemay el punto conocido.

Mientras mas lejano sea el punto, menos va a influir en el valor
final. Ahora n, controla que tanto influye uno que el otro, n
generalmente es 2, pero si se pone un valor mas alto, la
participacién seria menor si el valor se encuentra mas lejos. En
este caso, coinciden los aparatos con los valores conocidos. Ya que éstos vendrian siendo los que mas influyen.
Esto se debe principalmente al tipo de interpolacion. Los aparatos son mas bien visuales. Si esos aparatos no
influyen en tu decisién, no es necesario complicarse de mas, si llegan a influir en tu decision, debieras
considerar cambiar de método

Interpolate (cubic spline, de la familia de los Splines)

Ajustes de polinomios, en este caso utilizaremos un polinomio cubico
Dirigirse a: Processing = Toolbox (softwares acompafiantes) 2 SAGA (muy bueno para modelacion de
terreno) = Raster creation tools 2 interpolate (cubic spline)

4 Interpolate (cubic spline) ? *

Parameters  Log Run as batch process...

A
estrat_100_at [EPSG:32719] - -@

Atiribute
Jmu -

Minimal Number of Points

[z =]

Maximal Number of Points

[20 ]|

Paints per Square

[s 2]

Tolerance

[ 140.000000 =]

QOutput extent {xmin, xmax, ymin, ymax)

|3]841?10,318705.0,62?4005‘0,62?4421‘0 |

Cellsize:

[ 1000000 3.

0%

Cambiar nombre de salida por: jmu_spline

Como se puede ver, existen problemas de bordes, debido a la forma en que
interpola. ¢ Cdmo se soluciona? Poner un extent mas largo al de tu area de interés.
Nuevamente se ve que el fendmeno no se distribuye continuamente en el espacio,
comienzan a aparecer otras cosas.

0JO: Evitar crear carpetas con espacios o caracteres como la “fi”, en ocasiones la
herramienta se cae y no funciona.

PENDIENTE: Revisen qué pasa con los métodos de interpolacion probando con 1000
puntos y las diferentes distribuciones.




CONSTRUCCION DE DISTRIBUCION DE PUNTOS

1. Poner la capa: jmu (raster)
2. Iravector 2 Research Tools = diferentes herramientas que nos permiten hacer puntos de muestra

Vector | Raster Database Web  Processing Help

Opensteetiizp D o QMM oie €

| Research Tools * ‘ -‘1& Random points inside polygons {variable)
Geoprocessing Tools * |, Polygon from layer extent
Geometry Tools g t\‘,r— Select by location
Analysis Tools * . ,ij Random points inside polygons {fixed)
Data Management Tools  » E Random selection within subsets

Z&¢ Random points in extent

Viector grid
Random points in layer bounds

Random selection

Regular points

Utilizaremos el algoritmo Random points in extent, lo que permite la creacién de una capa de puntos con un
numero dado de puntos aleatorios, todos ellos dentro de una determinada extensién, y se puede especificar
un factor de distancias de estos puntos y permitir que éstos no queden cerca unos de otros. Los parametros
de esta herramienta son:

Parameters Log Run as batch process...

Input extent {xmin, xma, ymin, ymax)

| o]

Points number

B /-]

Minimum distance

0.000000 = EI

Random points
| [Create tempaorary layer] HZI
Open output file after running algorithm

-> Input extent -> use layer / canvas extent -> seleccionar la capa jmu. La opcidn Select extent on canvas
permite que el usuario defina las esquinas de la extensién en donde se desplegaran los puntos.

-> Point number: 100

-> Minimum distance: 10.

-> Random points -> Save to file -> mirnd_100

Muestreo sistematico
Para esta situacion, utilizaremos el algoritmo Regular Points, que permite la creacion de una capa de puntos
distribuidos regularmente en el espacio. Los pardmetros que completaremos en esta herramienta son:



Parameters Log Run as batch process...

Input extent (xmin, xmax, ymin, ymax)

| [

Point spacing/count

|o.000100 E"E

Initial inset from corner (LH side)

| 0.000000 = EI

[] apply randem offset to point spacding

Use point spacing

Regular points

| [Create temporary layver] ”Zl
Open output file after running algorithm

0%

Run | | Close

-> Input extent -> Use layer / canvas extent -> Seleccionar la capa jmu

-> Point spacing/count: 100

-> Initial inset from corner (LH side): esta opcién permite que los puntos se desplacen (en unidades del
mapa) de manera horizontal y vertical considerando la esquina superior izquierda de la capa raster utilizada
como input. Para esta situacion, dejar el valoren 0

-> Apply random offset to point spacing: Esta opcién permite agregar agregarle un poco de ruido aleatorio. Y
para este caso no marcaremos la casilla. Si se quisiera buscar aleatoriedad dentro del muestreo sistematico,
es mejor generar un muestreo estratificado

Nombre de salida del archivo: regular_points

Muestreo estratificado:

Para esta situacion, existen 2 algoritmos. Ocupar el menu Vector>Research Tools>

-> Random points inside polygons (variable): Este algoritmo permite la creacidon una nueva capa de puntos
aleatorios dentro de los poligonos de una capa dada. El nimero de puntos de cada poligono puede ser
definido como recuento fijo o valores de densidad. Los valores de recuento / densidad se obtienen desde los
atributos por lo que serdn diferentes por cada poligono del mapa base

-> Random points inside polygons (fixed): esta opcion crea una nueva capa con puntos aleatorios dentro de
los poligonos de una capa dada. El nimero de puntos en cada poligono puede ser definido como un valor fijo
o por valores de densidad, y sera la misma cantidad de puntos para todos los poligonos. Utilizaremos esta
opcién, y los pardmetros a completar seran:

Parameters Log Run as batch process...
Input layer
| -|l-][®]

Sampling strategy

| Points count hd |

Number or density of points

| 1.000000 EH D

Minimum distance

|0.000000 EH D

Random points
| [Create temporary layer] “Il
Open output file after running algorithm




-> Input layer: grilla_sist.shp
-> Sampling strategy: Permite especificar el nUmero de puntos que quiero dentro o la densidad. La densidad
define cuantos puntos existiran por unidad cuadrada de mapa (en este caso, metros). Utilizaremos nimero

de puntos (Points count). En el caso de que los poligonos sean de diferente tamafio, seria un buen motivo
para utilizar densidad

-> Number or density of points: 3
-> Minimum distance: 5
-> Nombre de salida: miestrat

Estos puntos sélo tienen la posicién que se encuentra en el mapa, y se puede comprobar en la tabla de
atributos en que solo observamos el campo ID. Nos vemos en la necesidad de agregar una columna que

otorgue el valor del pixel correspondiente a cada punto; esto podemos hacerlo a mano (utilizando el editor)
o con el pluggin "Point samplig tool"

-> Cargar pluggin: Point sampling tool

Search | point sa

- [ Aoz ]
F ] mnstalied

Vﬂlis plugin is trusted
Point sampling tool

Samples polygon attributes and raster values from multiple
layers at specified sampling points

Notinstalled

¥

The Point Sampling Tool Plugin collects polygon attributes and raster values from
multiple layers at specified sampling points. You need a point layer with locations of
sampling points and at least one polygon or raster layer to probe values from. The
plugin creates a new point layer with locations given by the sampling points and
attributes taken from all the underlying polygons or/and raster cells. Please use
Control and Shift keys in order to select multiple columns and bands. Note this tool is
not compatible with mulitipoint sources, unless each multipoint contains exactly one

point. Using multipeint samples that contain more points in multipoints may produce
unreliable results.

2

Antes de utilizar el pluggin, aplicaremos Zoom to layer a las capas que ocuparemos

General

-> Layer containing sampling points: Random points
-> Layers with fields/bands to get values from: jmu: Band 1 (raster)
-> Random points: id (source point)

General Fields About

Layer containing sampling points:

| Random peints

Layers with fields/bands to get values from:

fRandom points : id (source point) ]
grilla_sist : id {polygon)
grilla_sist : xmin {polygon)
grilla_sist : xmax (polygon)
grilla_sist : ymin (polygon)
grilla_sist : ymax (polygon)
[jru : Band 1 (raster)

Output point vector layer:

| Rnd_atrib | Browse

Add created layer to the TOC

Status:

Complete the input fields and press OK... oK | | Close




->Fields
Source: jmu
Name: jmu

m Fields About

source name

1 Random points:id id

2 jmu: Band 1 jmu

Status:
aK. The new Byer has been added fo the TOC.

->Nombre de salida Rnd_atrib

¢D6nde quedan esos puntos?. Si damos Ok, se cred un shape que se encontrara en el panel de layers.
Podemos guardar los puntos en formato CSV vy utilizarlos posteriormente en Excel

-> Click derecho a la capa creada recientemente Rnd_atrib -> Save as -> Format -> Comma Separated Value
-> Nombre de salida: puntos_terr

Format Comma Separated Value [CSV] -
Atlas BNA ~
File name AutoCAD DXF

Comma Separated Value [CSV

Layer name |ESRI Shapefile

GPS eXchange Format [GPX]

CRS GeolSON

GeoPackage

GeoRS5 H

Geoconcept

Encoding Geggramx Markup Language GML] hd

Save only selected features

P Select fields to export and their export options

Add saved file to map

Symbology export Mo symbology -
Scale 1:50000 :
w Geometry

Geometry type Automatic A

Force multi-type

Incude z-dimension

» [] Extent (current: layer)

¥ Layer Options

CREATE_CSVT |NO -
GEOMETRY | AS_XY -
LINEFORMAT | <Default> -
SEPARATOR  |COMMA -
WRITE BOM  [NO -




